
 Directory Toolkit Help Index

Directory Toolkit is an application meant to provide features missing from Windows 95 and 
Windows NT 4.0 or higher.    It allows files in two directories to be compared, provides renames, 
copy, move and delete of multiple files using wildcards while preserving long file names (the DOS 
commands dont), Decoding of files, splitting/concatenating of file to/from diskettes, Explorer 
compatible OLE drag and Drop, Sort Directories, opening files and launching applications.    The 
main features are listed below.

How to...

Compare and 
Synchronize 
Directories

Enter or select the Directories and file masks, then click the 
Compare Directories toolbar button or select it from File Menu.    
You can then Synchronize Directories.
To perform a binary compare on matched files, check    Binary 
Compare Files in the Options dialog.

Split a file Select a file, then right-click and pick Split File.    You can then 
select what size the files should be (default is the Max size a 1.44 
disk allows) and follow the on-screen instructions.    See the Split 
File dialog.

Concatenate Files Select the files to concatenate or simply select the menu item from
the context or File menu and you will be prompted for files to 
concatenate.    See the Concatenate Files dialog.

Decode a 
UUENCODED, 
Base64(MIME) or 
BinHex file

Click the right (left for left-handers) mouse button and use the pop-
up menu to select Decode.    If the file is UUENCODED, Base64 or
BinHex, encoded, you are prompted before decoding and saving 
the result file.

Encode a file in 
UUENCODED or 
Base64(MIME) 
format

Click the right (left for left-handers) mouse button and use the pop-
up menu to select Encode.    You then are prompted to select the 
encoding format (UUENCODE by default) in the Encode Files 
dialog.

Find duplicate files 
on a drive or two 
paths

Go to the Compare Options dialog (View/Options) and check the 
Match different duplicate files box.    Enter either the path you want 
to check in both path fields (ie. e:\ and e:\) or the two paths and 
switch to Compare Directories view or Refresh.    Files with 
different paths are matched and displayed.

Compare the 
contents of two files

Click the right (left for left-handers) mouse button and use the pop-
up menu to select    Compare Files or select it from the File Menu. 
The Compare Files dialog will then be displayed which will clearly 
show you the differences between the contents of the two files.

Rename, Move, 
Copy or Delete files 
using wildcards

To change the case of file names or perform file operations, select 
from the main menu or the context menu File Operations.    The 
File Operations dialog is then displayed and it will act either on the 
selected files or file masks you specify.

Touch Files Enter (or select from combo boxes) one or more file masks and a 
path.    You will be prompted for a date and time to use for all the 
files.    See the Touch dialog dialog.



Copy or move a file 
to/from the Explorer

You can drag files from the Directory Toolkit to the Explorer, 
desktop or a printer on the desktop for example.    If you drag items
from the Explorer to the Directory Toolkit or from one list to the 
other, the default operation is Copy(unless you hold the Control 
key down in which case the files will be moved there).

Sort Files in a 
directory

To physically sort the files in a directory, select Sort Files from the 
File Menu.    See the Sort Files dialog.

Use Command Line 
Parameters

See Command Line Parameters

View the Directory 
in a Sorted order

This can be done in One Directory mode only.    To sort the files by 
Name, Size or Date, click on that column.    If you click again, the 
sort order is reversed.    To sort by Type(extension), click on the 
Attrib column.
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File Menu

File Operations
This menu item allows you to Rename, Copy, Move or Delete the selected files or any files using a 
mask.    The masks are processed by a parser which preserves the long file names (unlike the DOS 
commands).    See File Operations dialog.

Sort Files
This menu item allows you to physically sort the files in a directory (not subdirectories), by name, 
type, size or date.    See Sort Files dialog.

Concatenate Files
This menu item allows you to concatenate the selected files or any files you want (from diskettes for 
example into one target file).    This option can be used with Split File (see below) to store a large file 
on multiple diskettes and put it back together (if it is already compressed for example).    See 
Concatenate Files dialog.

Touch
This menu item allows you to Touch (change the date and time) of selected files or all files in a 
directory and set them to any date and time you wish.    See Touch dialog.

Split
This item allows you to split a file into several (to store on diskettes) with a specified maximum size.    
See Split File dialog.

Decode
This menu item allows you to Decode a UUENCODED, Base64 or BinHex file.    The type is auto-
detected and, if the file is encoded, you are prompted before saving it.

Encode
This menu item allows you to select a file and encode it in UUENCODED or Base64 for transmitting 
over the Internet. You then are prompted to select the encoding format (UUENCODE by default) in 
the Encode Files dialog.

Open with Associated File
Select this item to open the first selected file in the Results list (if any) using the associated viewer. If 
no viewer is associated with that file extension, the default viewer (configurable in the Options dialog   
is used (default is NOTEPAD.EXE).

Open with Default Viewer
Select this item to open the first selected file in the Results List (if any) using the default viewer 
configurable in the Options dialog (default is NOTEPAD.EXE).

Open with...
Select this item to open the current file in the Results List (if any) using the a viewer of your choice.    
A Select Viewer dialog    will allow you to select the viewer to use.

Compare Files...
Select this item to view the differences between the selected file and another file. The Compare Files 
dialog will then be displayed which will clearly show you the differences between the contents of the 
two files.    If the Compare Directories view is used and the file exists in both directories, the program 
automatically compares the two files.



Select Newer Files Only
This menu item is only available in Compare Directories mode.    It will select the files which were 
found to be newer.    These are the files which the Synch Directories command (below) will copy.

Synch Directories
This menu item is only available in Compare Directories mode    This dialog allows you to copy newer 
or missing files or delete older files from the target directory.    Target Directory can be swapped and 
several options for updating are available.    See Synchronize Directories dialog.

Exit
Select this item to exit the application.



View Menu

Status Bar
Checked when Status Bar is Displayed.

Tool Bar
Checked when Tool Bar is Displayed.

One Directory
Checked when only One Directory is Displayed.

Compare Directories
Checked when the comparison of the files in two directories is displayed.

Include Subdirectories
Toggles the Include Subdirectories flag only in Compare Directories mode.

Refresh
Refresh the display (after and operation the application was not aware of).

Options
Select this item to display the Options dialog.



Directory Toolkit main window

Basic Functionality
Directory Toolkit is an application meant to provide features missing from Windows 95 and Windows 
NT 4.0 or higher.    It allows files in two directories to be compared, provides renames, copy, move 
and delete of multiple files using wildcards while preserving long file names (the DOS commands 
dont), Decoding of files, splitting/concatenating of file to/from diskettes, Explorer compatible OLE drag
and Drop, Sort Directories, opening files and launching applications.

The dialog box is sizable, maximizable and minimizable for your convenience.

The found strings and the files they are found in are clearly displayed in a list box using a 
custumizable color.

File Mask field
One or more search masks for files to display.    The masks are those used in the DOS dir command 
(Examples: *.*;*.txt;*.doc;*.??1).    More than one mask can be specified by using a semicolon 
separator (see example above). You can use the ~ character to denote a mask NOT to search (for 
example: *.*;~*.swp;~*.exe;~*.dll).    To specify a ~ as part of the file mask, use \~ (ie *.*;\~*.tmp).    
Your last few search file masks are saved for you by the application and you can find them in the 
combo box list.

Path 1 field
Path where files to display reside.    You may type it by hand, navigate to it by using the Browse button
described below, or select a previously used path from the combo list.    Your last few paths are saved 
for you by the application and you can find them in the combo box list.

Path 1 Browse button (... next to Path 1 field)
Click to select the path where files to display reside.    The Select Path dialog will be displayed to 
allow you to visually select the path.    If the Path 1 field (described above) contains a valid path, it will 
be your starting path in the Select Path dialog.    Otherwise, the current path will be used.

Path 2 field
Path where files to use for the second compare directory reside.    You may type it by hand, navigate 
to it by using the Browse button described below, or select a previously used path from the combo list.
Your last few paths are saved for you by the application and you can find them in the combo box list.

Path 2 Browse button (... next to Path 2 field)
Click to select the path where files to display reside.    The Select Path dialog will be displayed to 
allow you to visually select the path.    If the Path 2 field (described above) contains a valid path, it will 
be your starting path in the Select Path dialog.    Otherwise, the current path will be used.

Results List
Your results are displayed there.    For One Directory, you will see the files in the first directory.    If you
selected Compare Directories, you get a listing of the files in both directories side by side with the 
common files marked clearly.    You can select one or more files and perform operations on them, drag
them to copy or move them.    Context menus are available in both modes.



General Options dialog box

For more options see the Compare Options dialog.

Number of items to save
Select the maximum    number of items to save in the Mask and Path combo boxes.

If no association use and Browse button
Enter a file name for the default viewer (to be used when a file has no association). You may also use 
the Browse button to select a default viewer, in which case you will see Select Viewer dialog.

Confirm File Updates
Uncheck this box if you dont want prompts before overwriting files.

Compare Files Fields
Select Align Vertically if you want the files displayed side by side or Align Horizontally if you want to 
see them displayed one above the other.

OK button
The changes will be made.

Cancel button
The changes will not be made.



Compare Options dialog box

For more options see the General Options dialog.

Search subdirectories field
Check this field if you want to search all subdirectories of your path (this will usually slow your search 
down).    Uncheck it if you just want to search the specified path.    You can also change this field from 
the View Menu.

Binary Compare Files
Check this field if you want to check the same size files (with the same name) for identical content.    
Identical files will then be market as the same even if the dates are different.

Show Output to File:
You can enter a file to write the results of the Directory Compare to.    The file is TAB delimited and 
can then be easily imported into a spreadsheet or wordprocessor for a professional-looking report.

Sort By field
You can sort by Name, Type, Date or Size or select Unsorted to display in the order the files are in the
directory.

Ascending field
You can sort in Ascending Order (default) or Descending (if unchecked).

Match different duplicate files field
This feature allows you to find duplicate files on a drive by checking the box (in Options) and using 
the same path (ie. e:\ and e:\).    This option can also be used with different drives and files will be 
matched regardless of the complete path.    The See Synchronize Directories feature is not available 
when this box is checked.    You can use the File Operations dialog.

Display Identical Files field
You can uncheck this if you dont want to see the identical files.

Display Different Files field
You can uncheck this if you dont want to see the different files.

OK button
The changes will be made.

Cancel button
The changes will not be made.



File Operations dialog box

Basic Functionality
The File Operations dialog allows you to copy, rename, move or delete using selected files or masks.  
The long filenames are preserved (unlike the DOS commands which truncate them).    You can also 
change the case of the file names.

Operation Field
The four supported operations are listed.    The default is Rename unless:
- DEL is hit from the main window - in which case Delete is the default
- F7 is hit from the main window - in which case Move is the default
- F8 is hit from the main window - in which case Copy is the default
- Compare Directories is displayed - in which case Copy is the default
You can also change the case of file names by using Rename and special Mask To field 
characters. 
For example if you wanted all .HTM files to be lower case, you could use
Mask From:    *.HTM
Mask To: *<.htm    

If you want all files in a directory to be upper case, use:
Mask From:    *.*
Mask To: *>.*>

Path From field
Path where files to start the operation from reside.    You may type it by hand or navigate to it by using 
the Browse button described below.

Path From Browse button (... next to Path From field)
Click to select the path where files to start the operation from reside.    The Select Path dialog will be 
displayed to allow you to visually select the path. If the Path From field (described above) contains a 
valid path, it will be your starting path in the Select Path dialog.    Otherwise, the current path will be 
used.

Mask From field
Mask for files to start the operation from reside.    If you had selected files, you will see the first file 
name in the dialog.    You can use a mask which contains * and ?.    This mask will be validated 
against the Mask To field.    They need to have the same number of wild-cards in the same order.

Path To field
Path where files to move or copy to reside.    You may type it by hand or navigate to it by using the 
Browse button described below.

Path To Browse button (... next to Path To field)
Click to select the path where files to move or copy to reside.    The Select Path dialog will be 
displayed to allow you to visually select the path.    If the Path To field (described above) contains a 
valid path, it will be your starting path in the Select Path dialog.    Otherwise, the current path will be 
used.

Mask To field
Mask for files move or copy to reside.    You can use a mask which contains * and ?.    This mask will 
be validated against the Mask To field.    They need to have the same number of wild-cards in the 
same order.    You can make a portion of the files or the whole thing all upper or lower case by putting 
the > (for upper case) and < (for lower case) characters after each wildcard you want to change.    If 
you need to use < or > as part of the mask, simply precede them by a \.



Important note:
For example if you wanted all .HTM files to be lower case, you could use
Mask From:    *.HTM
Mask To: *<.htm    

If you want all files in a directory to be upper case, use:
Mask From:    *.*
Mask To: *>.*>

OK button
The changes will be made.

Cancel button
The changes will not be made.



Touch Dialog

This window allows viewing and changing the date and time which will be assigned to the files using the 
masks specified.

Date field
Select the date to be used (in format mm/dd/yy or mm/dd/yyyy).

Time fields
Select the time to be used (in format hh or hh:mm or hh:mm:ss) and AM or PM (do not use military 
time).

OK button
The dates and times will be set for all the files found using the masks specified.

Cancel button
No files will be touched.

Update button
The date and time will be refreshed using the current date and time (on the PC clock).



Sort Files Dialog

This window allows physically sorting the files in a directory.    The files are    removed then put back in the
Directory using native Operating System functions therefore this operation can be performed regardless 
of file system (assuming you have permission to do so).    Subdirectories are not sorted (they will show at 
the top).

Path field
Path where files to sort reside.    You may type it by hand or navigate to it by using the Browse button 
described below.

Path Browse button (... next to Path field)
Click to select the path where files to sort reside.    The Select Path dialog will be displayed to allow 
you to visually select the path. If the Path field (described above) contains a valid path, it will be your 
starting path in the Select Path dialog.    Otherwise, the current path will be used.

Sort By field
You can sort by Name, Type, Date or Size.

Ascending field
You can sort in Ascending Order (default) or Descending (if unchecked).

OK button
The operation will be performed.

Cancel button
No action will be taken.



Concatenate Files Dialog

This dialog allows you to concatenate multiple files into one target file.    The file list need not be set from 
the beginning.    You will be prompted for additional files to concatenate.

Target File field
Enter a file to save to or use the Browse button described below to select one.

Target File browse button
You may select a target file. The File Save As dialog is displayed.

Files to Concatenate List
The list contains the files to concatenate in the order they will be used.    You will be prompted for 
additional files after these files are concatenated.

Move Up button
Allows you to select a file and move it up in the list.

Move Down button
Allows you to select a file and move it down in the list.

Remove Button
Allows you to remove the selected file from the list.

Decode when done field
Allows you to decode the Target File if it is UUENCODED, Base64(MIME), BinHex,    XXENCODED or
encoded with a user-defined table.    This is equivalent to selecting the Target File and selecting 
Decode from the File Menu.

OK button
Concatenates selected files (if any), then prompts user for additional files (if on diskette for example).

Cancel button
No action will be taken.



Encode Files Dialog

This dialog allows you to one or more files into one file for sending as Internet mail.

Target File field
Enter a file to save to or use the Browse button described below to select one.

Target File browse button
You may select a target file. The File Save As dialog is displayed.

Files to Encode List
The list contains the files to encode in the order they will be used.

Move Up button
Allows you to select a file and move it up in the list.

Move Down button
Allows you to select a file and move it down in the list.

Remove Button
Allows you to remove the selected file from the list.

Emcoding Type field
Allows you to select either UUENCODED or Base64(MIME) encoding type.

OK button
Encodes selected files in the order specified into the target file.

Cancel button
No action will be taken.



Compare Files Dialog

This dialog allows you to view the differences between two files. If one of the files is binary, a 
Hexadecimal Dump format is used, rather then a line-by-line comparison.    To change to position of the 
listing windows, see the Options dialog.

Compare button
Performs the compare operation using the files selected.

File 1 button
You may select a file to compare. The File Open dialog is displayed.    Alternatively, you can drag a file
from the Explorer to the box below this button to select the file.

File 2 button
You may select a file to compare. The File Open dialog is displayed.    Alternatively, you can drag a file
from the Explorer to the box below this button to select the file.

Comparison List
The list contains the sections that are different or alike in the two files.    Sections denoted with yellow 
are moved.

File 1 Contents
You can view the contents of the file as compared to the other file.    Sections that differ are shown in 
red, moved sections in blue while identical sections are shown in black.

File 2 Contents
You can view the contents of the file as compared to the other file.    Sections that differ are shown in 
red, moved sections in blue while identical sections are shown in black.



Synchronize Directories Dialog

This dialog allows you to copy newer file or delete older files from the target directory .

Swap Button
Alows you to change(swap) the source and target directories.

Synchronize Both field
Selecting this item will add new files to both directories and copy newer common files from either 
directory to the other.

Augment Target field
Selecting this item will add new files from the source directory to the target directory.    You can swap 
the source and target by using the swap button.

Refresh Target field
Selecting this item will update only existing files from the source directory to the target directory.    You
can swap the source and target by using the swap button.

Update Target field
Selecting this item will update existing and add new files from the source directory to the target 
directory.    You can swap the source and target by using the swap button.

Update & Prune Target field
Selecting this item will first delete files in the target directory that cannot be found in the source 
directory, then update existing and add new files from the source directory to the target directory.    
You can swap the source and target by using the swap button.

Remove Duplicates from Target field
Selecting this item will delete files in the target directory that were found in the source directory and 
were identical.    If the Binary Check Files Option is set, files whose contents are identical are 
considered identical, otherwise if the date and time are the same the files are considered identical. 
You can swap the source and target by using the swap button.

OK button
Performs the operation requested.

Cancel button
No action will be taken.



Split File Dialog

This dialog allows you to split a file into multiple files of a given size.    These files can be stored directly 
on floppies (the default size assumes that).

File Name field
Enter a file to split or use the Browse button described below to select one.    The file selected (if any) 
in the main window is used by default.

File Name browse button
You may select a file to split. The Open File dialog is displayed.

File Size field
Enter the maximum size of the files produced.    The maximum size of a file stored on 3.5" floppies 
can be found in the combo box with the 1.44MB as the default.

Destination Path field
Path where files will reside.    You may type it by hand or navigate to it by using the Browse button 
described below.    The default is the first floppy drive (A:\).

Destination Path Browse button (... next to Path field)
Click to select the path where split files will reside.    The Select Path dialog will be displayed to allow 
you to visually select the path.    The default is the first floppy drive (A:\).

Remove Button
Allows you to remove the selected file from the list.

OK button
The file is split(copied to one or more files).    If more floppies are needed, you will be prompted.

Cancel button
No action will be taken.



Command Line Parameters

Command -line parameters can be used as follows:

/b Synch Both Directories.    See Synchronize Directories dialog for a more 
detailed description.

/a Augment Target Directory.    See Synchronize Directories dialog for a more 
detailed description.

/r Refresh Target Directory.    See Synchronize Directories dialog for a more 
detailed description.

/u Update Target Directory.    See Synchronize Directories dialog for a more 
detailed description.

/p Update & Prune Target Directory.    See Synchronize Directories dialog for a 
more detailed description.

/d Remove Duplicates from Target Directory.    See Synchronize Directories dialog 
for a more detailed description.

/c Compare Directories mode by default.
/sC:\Source Path for Source Directory (Path 1).
/TC:\Target Path for Target Directory (Path 2).
/q Quit after operation.    Application will close after the operation is completed.

The flags can be upper or lower case. Only one of the barupdc flags should be specified.    Here are some
examples:

DIRTKT /sc:\work /td:\Program Files\Excel /m*.xls
DIRTKT /sc:\work /td:\Program Files\Excel /m*.xls /rq



About Box

This window contains system and copyright information.    Click the Ordering Info button for 
Ordering Information or the License Info button for License Information.
For customer support, contact 102372.2530@compuserve.com.



Ordering Information

As part of the registration, you will also receive free updates and customer support (by E-MAIL) for a year.
Updates are sent to registered customers quarterly.    They incorporate your suggestions so please 
send them.    If you have problems receiving the program or need customer support, contact us 
directly by E-MAIL at 102372.2530@compuserve.com.    Quantity discounts are listed on the WWW 
at: http://home.sprynet.com/sprynet/funduc or http://ourworld.compuserve.com/homepages/funduc.

· Ordering by check:    To order by check send this order form and a check for $20 (+$3-$5 if you want a
diskette mailed) to Funduc    Software Inc., P.O. Box 530904 Livonia, MI 48153.      Please allow 7-
10 days for mail to reach you, then contact us by E-MAIL if you did not receive the program. To print 
this order form, click on Print Topic in the File pull-down menu or print the ORDER.TXT file. 
Payments must be in US dollars drawn on a US bank or international postal money order in US
dollars.

· CompuServe subscribers may register by typing GO SWREG and using the Registration ID 12272 
(the cost is $23/user due to CompuServe charges).      CompuServe orders are filled by E-MAIL within 
24-48 hours regardless of delivery method selected.    Therefore please check your CompuServe mail
a day or two after ordering.

· You can also register by using your credit card and a secure Web browser (such as Internet Explorer 
or Netscape) from the URL: http://home.sprynet.com/sprynet/funduc or 
http://ourworld.compuserve.com/homepages/funduc. To register by Fax, call: (813) 526-2924.    
Specify order is for Directory Toolkit. The cost through this option is $25/user + $3-$5S&H if you want 
a diskette mailed (E-MAIL delivery is free). If you want, you can call (800)500-0326 or (352)315-6330 
to order.    This option is more expensive(due to extra charges), but you can get the program within 2 
business days(if your mail system can receive MIME attachments).

Please check one: __ E-MAIL(please include your address)
__ 3.5" Disk (please add $3 or $5 for S&H below) 

Directory Toolkit for Windows 95/NT ____        copies at $20 each _______
Michigan residents add 6% sales tax _______
For snail mail delivery (3.5" disk) in the United States 
add $3.00 or $5.00 for    overseas

_______

Total payment __________

Prices subject to change without notice.

                        Name: _______________________Date:___________

                  Company: _______________________________________

                  Address: _______________________________________

City, State, Zip: _______________________________________

                  Country: _______________________________________

              Day Phone: _________________Eve:__________________

                                  FAX:__________________

Electronic Mail address: ________________________________

How did you hear about Directory Toolkit for Windows 95? 



__________________________

Comments:
 



License Information

Copyright/License/Warranty

For ordering information, see the section Ordering Information.

Directory Toolkit Copyright (c) 1995-1996 by Funduc Software Inc. - All rights reserved.

License Agreement and Warranty Disclaimer

You should carefully read the following terms and conditions before using this software.    Use of this 
software indicates your acceptance of these terms and conditions.    If you do not agree with them, do not 
use the software.

Shareware Version

You are hereby licensed to: use the Shareware Version of the software for a 21 day evaluation period; 
make as many copies of the Shareware version of this software and documentation as you wish; give 
exact copies of the original Shareware version to anyone; and distribute the Shareware version of the 
software and documentation in its unmodified form via electronic means.    There is no charge for any of 
the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission.

Unregistered use of Directory Toolkit after the 21-day evaluation period is in violation of federal copyright 
laws.

Evaluation and Registration

This is not free software.    This license allows you to use this software for evaluation purposes without 
charge for a period of 21 days.    If you use this software after the 21 day evaluation period a registration 
fee is due (see Ordering Information).

Customer support can be obtained by visiting our homepage at http://home.sprynet.com/sprynet/funduc 
or http://ourworld.compuserve.com/homepages/funduc or by E-MAIL (102372.2530@compuserve.com).

One registered copy of Directory Toolkit may be dedicated to a single person who uses the software on 
one or more computers or to a single workstation used by multiple people.

You may access the registered version of Directory Toolkit through a network, provided that you have 
obtained individual licenses for the software covering all workstations that will access the software 
through the network.

Governing Law

This agreement shall be governed by the laws of the State of Michigan.

Disclaimer of Warranty

This software and the accompanying files are sold "as is" and without warranties as to performance of 



merchantability or any other warranties whether expressed or implied.    In particular, there is no warranty 
for the string Replacing feature.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it.    The user must assume the entire risk of using the program.    Any liability of the 
seller will be limited exclusively to product replacement or refund of purchase price.



Select Path dialog box

Directories
Select the directory where the files you want to view reside.

Drive
Select the drive where the files you want to view reside.

OK button
The path you selected will be used.

Cancel button
The path will not be changed.



File Open/Select Viewer dialog box

File Name
Select or type the name of the document you want to open. This box lists documents with the 
filename extension selected in the List Files Of Type box. To see a list of files with a particular 
extension, type an asterisk (*), a period, and the three-character extension, and then press ENTER. 
To see files with more than one filename extension, type a semicolon (;), a second asterisk (*), a 
period, and another three-character extension. For example, if you 
want to see all files with the .TXT extension and all files with the .INI extension, type *.txt;*.ini.

List files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory where the files you want reside.

Drive
Select the drive where the files you want reside.

OK button
The File you selected will be used.

Cancel button
The File will not be used.



File Save dialog box

File Name
To save a document with a new name, in a different file format, or in a different location, type a new 
filename.    To save a document with an existing filename, select the name in the list or type the 
current name.

Save files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory where the files you want to search reside.

Drive
Select the drive where the files you want to search reside.

OK button
The File you selected will be used.

Cancel button
The File will not be used.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




